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1 Introduction

Hospitality Service Center  (HSC) V2.6 Entry is an application intended for the hospitality 
industry. It combines the communication features of OpenScape Office LX/MX or HiPath 3000 
with a Front Office System and optimizes hotel processes.

The system offers a great amount of hospitality industry features:

● Room grid for the management of reservations and occupations

● Display and modification of telephone functions directly in the Room Grid:

● Do not disturb

● Telephone authorizations

● Standard wakeup calls

● Extended wakeup call service (voice message in the guest's language)

● Room status management

● Comfortable Invoicing of all hotel services

● Reports on charges and room statuses, arrival lists, departure lists, guest lists or wakeup 
call lists

● Reservation confirmations and charge lists are exported to Microsoft Word, where they can 
be further processed

1.1 Target Group

HSC Entry has been designed for small hotels. Therefore, HSC Entry supports all workflows of 
a small hotel directly from the Room Grid and displays the states of the room telephones.

This manual is designed to support hotel receptionists . The reception desk users are working 
with the HSC Room Grid, they are responsible for checking in/out of hotel guests, entering 
reservations and preparing charge accounts.

For using this manual experience with Microsoft Windows products is required.
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Structure of the Manual

1.2 Structure of the Manual

The manual provides a detailed description of HSC Entry as well as an instruction on how to 
use the individual HSC functions. The manual consists of the following main chapters:

Chapter 1 - Introduction  provides you with basic information about HSC and its users, 
describes the login process and gives a short overview of the most frequently used functions 
of Front Office.

Chapter 2 - Room Grid  comprises a detailed description of the functions of the Room Grid, 
which is used for managing check in/check out processes, reservations etc.

Chapter 3 - Reports describes the reports that you can generate with HSC. HSC can generate 
a number of work lists, making it easier for your staff to keep track of the activities to be 
performed.

Chapter 4 - HSC Front Office  Basic Functions  describes basic functions of the HSC user 
interface, e.g. the use of the online help.

Chapter 5 - HSC Telephone Interfaces  describes how both guests and hotel employees can 
use the functions of the telephone interfaces.

Appendix A - Adaptation of Reports  describes how reservation confirmations and charge 
lists can be adjusted.

The Index  is a tool which provides fast access to detailed information on a given topic.

1.3 Notational Conventions

● In the text, screen elements are displayed in italics.

● Important information in the text is highlighted in bold .

● The keys of your keyboard are displayed in italics, in angle brackets (e.g. <Alt>).

● The > sign describes paths through menu items you have to select to reach a certain 
feature.

> Indicates notes.

7 Indicates warnings.



u-chap1-V25Entry_en.fm

A31003-E1325-U100-4-7619, 09-2008
HHSC V2.5 Entry, User Guide 1-3
       

Introduction
Starting of HSC

1.4 Starting of HSC

In order to start HSC, please double-click the HSC icon on the Windows desktop.

1.5 Login

As soon as you have started HSC, the Login window will be displayed on your screen after a 
short loading time.

Enter your User name and your Password and click OK. 

Figure 1-1 Login Window

User name

Enter your user name. After installation, a user account designated admin  is provided.

Password

Enter your password. For the default user "admin" the default password is also admin .  
Please change this password immediately after the first login!

Thus you confirm your entries and you will be logged in.
The HSC Entry main desktop will be displayed on your desktop.

Closes the window without starting HSC.

>
You can always change your password in the User Settings window which you can 
access via the menu item Administration > User Settings...; new users can be set up 
via Administration > User Accounts... (see Service Manual).
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Quick Overview

1.6 Quick Overview

This section is designed to get you acquainted quickly with the most important features of the 
HSC Entry Room Grid. The short overview provided in this section will explain typical scenarios 
as they are encountered in the daily work with HSC.

When starting HSC for the first time, you will immediately see the Room Grid (see Figure 1-2). 
For a more detailed description of the options offered see Chapter 2, “Room Grid”.

Each line in the Room Grid represents an individual room. In the header above the date is 
displayed. The green bars represent checked-in guests, the blue ones are reservations. By 
clicking the mouse key over the requested date, pressing the left mouse key and moving to the 
right until the requested end date is reached, a new bar can be created. Existing bars can be 
edited by clicking the left mouse key and the context menu subsequently displayed.

In the lower sector of the Room Grid a line shows the number of free rooms.

> Please note that you can get help anytime regarding your current work step by 
pressing the F1 button.
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Figure 1-2 The Room Grid

Now let's move to some typical scenarios.

1.6.1 The Guest Reserves a Room

The guest calls and wants to book a room. You consult the Room Grid and look for a vacant 
room for the requested time period. Then you click on the planned arrival date in the line of the 
selected room, draw the bar to the number of nights with the mouse and release the left mouse 
key. A context menu with the available functions is offered. In this menu, select Reservation... 
(see Figure 1-3).



Introduction

 A31003-E1325-U100-4-7619, 09-2008
1-6 HHSC V2.5 Entry, User Guide

      

u-chap1-V25Entry_en.fm

Quick Overview

Figure 1-3 Reservation

In the example in Figure 1-3 the reservation in room 103 is executed. The only thing left to do 
is to enter the guest data in the dialog displayed (see Figure 1-4).

Alternatively, also a group reservation can be created, with several rooms reserved for one 
group (see Section 2.3, “Group Reservation”).
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Figure 1-4 Enter Reservation Data

For more information on this subject see Section 2.2, “Reservation for Individuals”.

1.6.2 The Guest Arrives

If the guest finally arrives and wants to go to his or her room, look for the respective reservation 
bar in the Room Grid. Select it by clicking the right mouse button and in the context menu 
displayed, select Check-in (see Figure 1-5).

This will immediately check in the guest. For more information see Section 2.5, “Check-in of a 
Guest”.

If a guest arrives who has not made an advance reservation, he or she can also be checked in 
immediately. In this case the guest data still have to be entered.

Alternatively, a guest can be checked in via the menu Quick Check-in without the need to enter 
the guest's data.
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Figure 1-5 Check In

1.6.3 The Guest Leaves

If the guest wants to check out, go to the respective bar in the Room Grid and click it with the 
right mouse key. In the context menu now displayed, select the menu item Check-out...  (see 
Figure 1-6).

If the guest wants to check out the day before he leaves, proceed as described in Section 2.6, 
“Check-out”.
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Figure 1-6 Check Out

In the simplest of cases, if no telephone or internet charges have accrued, a security check is 
displayed and the guest is checked out. If charges have to be accounted, a moneybag in the 
Charges column is displayed. In this case a charge list will be displayed before the check-out. 
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Figure 1-7 Charge List

This charge list can be printed out by means of Pay All and charged to the guest to terminate 
the check-out procedure.

For more information on the check-out procedure see Section 2.6, “Check-out”. For more 
details regarding the charge list see Section 2.7, “Charge List”.
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2 Room Grid

The Room Grid offers a clear overview of the current room status in the shape of a calendar 
and allows the receptionist to perform check-in/check-out processes easily. The Room Grid is 
immediately displayed after first starting of HSC. If you close it, you can easily access it via the 
toolbar or via the menu Front Office > Room Grid...

The Room Grid comes as a table. On the vertical axis the configured rooms can be seen, sorted 
in ascending order by room numbers.

Figure 2-1 Room Grid

Next to the room number, status information on the room can be seen in separate columns for 
each room. This status information can be changed directly in the Room Grid by means of the 
mouse:

● The Room Status: indicates whether the room is clean or still has to be cleaned (see 
Section 2.15, “Room Status”).
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● Whether a Do not Disturb (DND) has been set for the guest, preventing that the guest is 
called directly (see Section 2.12, “Do Not Disturb (DND)”).

● Whether the respective room has the authority to make external calls over the trunk line 
and access to the Internet is allowed or not allowed (see Section 2.13, “Lock of Call 
Authorization and Internet Access”).

● Whether a wakeup call has been set for the room (see Section 2.11, “Wakeup Calls”).

● Whether there is a message for the room (see Section 2.14, “Messages”). 

● Charges indication for the room: a moneybag will be displayed if charges still have to be 
paid for the respective room. The concrete consumptions can then be viewed by right-
clicking on this column and selection of the context menu Charges... on the room (see 
Section 2.7, “Charge List”).

● Whether a call forward has been set for this room (only display).

The individual columns can be shown/hidden. For this purpose use the right mouse key to click 
on the column heading. A window with the possible columns will be displayed, in which by 
checking the respective titles it can be determined which columns shall be displayed. You can 
change the order of the columns by means of drag and drop.

On the horizontal axis the time is displayed. The current day is always displayed by a yellow 
bar. Saturdays and Sundays are highlighted in orange, Saturdays somewhat lighter than 
Sundays. Days that are in the past are displayed in grey or dark-grey (Sundays).

By means of the time navigation bar it is possible to navigate in either direction (forward or 
backward) (see Section 2.1, “Time Navigation”).

The receptionist may now

● make reservations for the individual guest or delete them (see Section 2.2, “Reservation 
for Individuals”)

● make or delete reservations for a group (see Section 2.3, “Group Reservation”)

● make a quick check-in without reservation, where the guest data are not entered 
immediately (see Section 2.5.4, “Quick Check-in”)

● perform a check-in without reservation (see Section 2.5.2, “Check-in without Reservation”)

● perform a check-in based on the reservation of a guest or a group (see Section 2.5.1, 
“Check-in after Reservation” and/or Section 2.5.3, “Check-in of a Group”)

● perform a check-out of a guest (see Section 2.6, “Check-out”)

● enter events in an event calendar (see Section 2.9, “Event Calendar”)

● check the overall availability of rooms (see Section 2.10, “Room Availability”)
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● set the room status of a room from "Uncleaned" to "Cleaned" (see Section 2.15, “Room 
Status”). 

● edit wakeup calls for a room (see Section 2.11, “Wakeup Calls”)

● set or reset a Do Not Disturb for a room (see Section 2.12, “Do Not Disturb (DND)”)

● (de)activate the locking of telephone calls over a trunk line and of the access to the Internet 
(see Section 2.13, “Lock of Call Authorization and Internet Access”)

● view the charge list of a room (see Section 2.7, “Charge List”) or the general account (see 
Section 2.8, “General Account”)

● edit the occupation of a room, e.g. to change guest data or determine a new call charge 
credit limit (see Section 2.5.5, “Occupation”).

● view or print out today's arrival list (see Section 2.16, “Arrival List”)

● view or print out today's departure list (see Section 2.17, “Departure List”) 

● create work lists (see Chapter 3, “Reports”).

2.1 Time Navigation

For time navigation in the Room Grid arrows are provided for moving forward or back in time.  
The default single arrows will take you in the requested direction in one-day steps. The double-
headed arrows are used for moving the view by one week. With the three-headed arrows 
forward and backward navigation by a whole month is possible.

By clicking Today the view is set to the current date (highlighted in yellow).

In addition, the date indicated in the date field next to it can be set directly to a respective day.

Optionally also a scrollbar can be displayed for faster navigation using the mouse. This 
scrollbar is used for navigating forward and backward in time. The visibility of the scrollbar can 
be set by means of Timeline Scrollbar in the View menu.

2.2 Reservation for Individuals

To make a reservation for an individual, the receptionist has to select the arrival date (column) 
and the requested room (line) in the Room Grid. Then, by suppressing the mouse key, a bar 
can be drawn to the requested check-out date. When the mouse key is released, a context 
menu will be displayed offering the available options. The receptionist now selects the menu 
item Reservation... and the dialog box of the same name will pop up.
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Reservation for Individuals

Figure 2-2 Reservation Dialog

Here the receptionist can enter the data of the guest. The minimum entry requirements are the 
family name and the first name of the guest as well as his or her preferred language. In addition, 
a remark may be added (optional).

Under Call charge credit limit a limit for call charges can be entered. If this limit has been spent, 
no more telephone calls can be made. This is also indicated in the Room Grid in the Charges 
column (see Section 2.7, “Charge List”).

Alternatively, a reservation can be initiated also directly, i.e. not via the Room Grid. To do so, 
you have two options: either via the toolbar icon or via the menu item Front Office > 
Reservation...  In this case, enter the arrival and departure dates (or, alternatively, the arrival 
date and the number of nights the guest is planning to stay).

The reservation may be changed any time in the Room Grid. The planned arrival and departure 
dates can be moved by drawing the mouse to another date. Reservation can be moved to an 
earlier or a later period by moving the reservation bar. Please note that reservations can start 
on the current date at the earliest.

You can remove reservations by simply selecting the context menu Delete Reservation. 
Changes to reservation data can be made via the context menu Edit Reservation... If you want 
to change the date of a reservation and this date then overlaps with another reservation, the 
reservation cannot be changed and HSC gives out a warning by displaying an error dialog.

By selecting the context menu Print Reservation Confirmation a reservation confirmation can 
be printed (see Section 2.4, “Reservation Confirmation”).

Reservation for individuals.
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2.3 Group Reservation

In HSC V2.6 Entry it is also possible to make reservations for entire groups in a convenient one-
step process. The receptionist selects the requested period for a room as described in Section 
2.2, “Reservation for Individuals”, however then selects the menu item Group Reservation...

Thereafter the requested rooms have to be selected in the Group Reservation dialog. For the 
group reservation the name of the group is entered and the preferred language is selected.

The rooms that are to be reserved for this group have to be selected in the list Vacant Rooms 
and added by Add to the list Selected Rooms. The individual rooms are then reserved for this 
group. As soon as these rooms are not occupied, they can be removed from the group by using 
Remove. 

Figure 2-3 Group Reservation

It is not possible to convert a group reservation into individual reservations, however it is 
possible to remove individual rooms from a group reservation or add new ones. An existing 
group reservation can be changed by using Edit Group Reservation... 

The group name and the language as well as the selected rooms can be changed subsequently 
any time by using the same dialog. The date can be changed subsequently only in the resulting 
individual reservations (by means of Edit Reservation...).
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In case of a group reservation the members of the group can either be checked in individually 
or as a group. For the latter please use the context menu Group Check-in (see Section 2.5.3, 
“Check-in of a Group”). The entire group will be checked in only if no room reservation of a 
group member overlaps with another reservation.

When deleting a reservation that is part of a group reservation, the receptionist can decide 
whether he or she wants to delete the entire group reservation (by Delete Group Reservation) 
or only the reservation for the selected room (by Delete Reservation). 

By means of the context menu Print Group Res. Confirmation a group reservation confirmation 
can be printed out. In this process the name of the group, the period and the number of rooms 
are listed. Alternatively, also reservation confirmations for individual reservations can be 
printed out (see also Section 2.4, “Reservation Confirmation”).

2.4 Reservation Confirmation

For an existing reservation a reservation confirmation can be printed out any time. For this 
purpose select a reservation in the Room Grid and select Print Reservation Confirmation or 
Print Group Res. Confirmation.

HSC then creates a reservation confirmation for the guest or the group. Depending on the 
settings in the menu Administration > System Settings… > Reporting, the confirmation is either 
generated directly or HSC will start Microsoft Word with the configurable document template. 
For adaptation of the printouts see Appendix A.2, “Reservation Confirmation”.

2.5 Check-in of a Guest

If the guest arrives at the hotel, he or she has to check in. In this process the room telephone 
is adapted to the guest, the name and the call authorizations are configured. The telephone 
and the access to Internet can be locked for the guest, or a call charge credit limit for telephone 
calls and use of Internet can be defined.

Below the different methods of check-in are described:

● Section 2.5.1, “Check-in after Reservation”

● Section 2.5.2, “Check-in without Reservation”

● Section 2.5.3, “Check-in of a Group”

● Section 2.5.4, “Quick Check-in” (Check-in of a guest without entering the guest data)
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2.5.1 Check-in after Reservation

If the guest already had a room reservation, the receptionist may right-click on this reservation 
in the Room Grid and select the context menu Check-in.

Alternatively, you can browse for the guest in the arrival list and perform the check-in procedure 
from this list (see Section 2.16, “Arrival List”).

2.5.2 Check-in without Reservation

If a guest has not made a reservation, a room has to be selected for him or her by adopting the 
same procedure as in a reservation and by moving the mouse over the requested period. 
Subsequently it is not the context menu Reservation... that is selected but directly the context 
menu Check-in. 

Thereafter the guest data have to be entered just as if a reservation had been made (see 
Section 2.2, “Reservation for Individuals”). This will immediately check in the guest.

2.5.3 Check-in of a Group

Check-in of a group can be performed by the context menu Group Check-in of the group 
reservation. If the check-in was performed based on an existing group reservation, all group 
members will be checked in immediately.

If the check-in of the group is performed ad-hoc, i.e. without previous reservation, the group 
name, the language, the period, as well as the rooms to be occupied by the group, have to be 
entered.

In addition, the list of requested rooms has to be selected in the same way as in group 
reservation and added by using the Add function. The rooms that are vacant in the selected 
period are listed under Vacant Rooms, rooms set aside for the group are entered in the list 
Selected Rooms.

After selecting Check-in, all group members are checked in at once.

An existing group occupation can be subsequently changed by Edit Group Occupation... In this 
process new reservations for the group can be added, and the group name or the preferred 
language can be changed.

2.5.4 Quick Check-in

Quick check-in is useful for checking in a guest without having to enter his or her data at once. 
The guest is checked-in with predefined data, with the room number serving as a wildcard for 
the guest name and the default language of HSC being used for the guest. Thus the time 
needed for check-in can be reduced.
The default language can be set via the administration menu (see Service Manual).



Room Grid

 A31003-E1325-U100-4-7619, 09-2008
2-8 HHSC V2.5 Entry, User Guide

      

u-chap2-V25Entry_en.fm

Check-out

Quick check-in is performed like a normal check-in process: First the time period is highlighted 
in the Room Grid by moving the mouse to the requested room, then the menu item Quick 
Check-in is selected from the menu options offered. This procedure terminates the check-in 
process with the wildcard data at once.

The real guest data can be added later, by selecting the respective reservation bar and the 
context menu Edit Occupation… (see Section 2.5.5, “Occupation”).

2.5.5 Occupation

As soon as a guest has been checked in, the room occupation is displayed by means of a green 
bar until he or she checks out again. This active occupation may be changed any time via the 
context menu Edit Occupation... In this process the name of the guest, the preferred language, 
the departure date and perhaps the telephone charge credit limit can be changed later on.

Figure 2-4 Edit Occupation

Past reservations are displayed by grey bars and can be viewed with Show Details..., however 
can no longer be changed.

2.6 Check-out

There are two options for checking out a guest:

1. select the respective bar via the Room Grid and use the context menu item Check-out 

2. or you can use the departure list, if the guest wants to check out on the day prior to his 
or her planned departure (see Section 2.17, “Departure List”). 
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Upon check-out, please note the cases described below:

1. The guest has no open charges and does not make a phone call: the check-out 
procedure can be completed at once. A security prompt only requires a short 
confirmation of the check-out process.

2. The guest has open charges: in this case they have to be settled first and then the 
check-out process can be completed (see also Section 2.7, “Charge List”).

3. The guest is currently making a phone call: in this case the receptionist can decide 
whether to cancel the check-out process or whether to ignore the phone call. If he/she 
opts for cancelling, the guest will not be checked out and the telephone call is charged 
to the guest account. If he/she opts to ignore the telephone call, the related costs are 
accounted to General Accounts (see Section 2.8, “General Account”).

If a guest wants to check out the day before he or she leaves, proceed as follows:

1. Lock the telephone of the respective guest (see Section 2.13, “Lock of Call 
Authorization and Internet Access”).

2. View the charge list of the room and charge open charges by Pay All (see Section 2.7, 
“Charge List”).

3. Check the guest out only when he/she really has left the room and returned the key by 
using Check-out.

2.7 Charge List

If a guest still has open charges he or she has not settled yet, the Charges column is 
represented in the Room Grid as a moneybag.

If the services charge credit limit set for this guest has been reached, this is indicated with the 
following icon. The services charge credit limit can be increased by editing the Room Grid (see 
Section 2.5.5, “Occupation”).

By right-clicking on the icon in the Charges column and selecting the context menu Charge 
List... the charge list of this room is presented. As an alternative, this context menu can also be 
launched via the respective occupation bar.

Unsettled charges.

Call charge credit limit reached.
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2.7.1 Guest Cashier

Guest Cashier module includes individual guests charges records for each of the hotel’s 
Checked In guests. With this module you can post, modify or transfer charges, print the invoice 
and perform Check Out. Individual guest account remains open continuously until guest is 
Checkd out. Settled account is a prerequisite for Checking out from the hotel.

Figure 2-5 Guest Cashier
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2.7.2 Adding Services/Products

Hotel services and products are grouped into categories:

● Hotel Services

● Food

● Beverages

● Alcoholic beverages

● Services

Figure 2-6 Guest Cashier - Services/Products

All Products/services are accesible in relevant category. To add Product/Service click on ">" 
button.

Figure 2-7 Guest Cashier - Edit Service/Products

Guest services are booked as occupation and number of days. Other Products/Services are 
booked with Product/Services quantity. All Products/Services on account are editable. 
Individual Product/Service can be removed from account if you cklick on "I" button. When you 
finish editing click on "Save" button.
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2.7.3 Separated Invoices

If guest/sharing person requires a separate invoice for his/her service/accomodation, please 
use "New Folio" option from drop down menu.

Figure 2-8 Separated Invoices - New folio

For each new Folio Guest name can be addopted with click on Change Name button.
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2.7.4 Invoicing

Invoice is issued with cklick on "Issue Bill" button. You can select Payment method using drop 
down menu. Several Payment methods can be combined to seattle the invoice.

Figure 2-9 Invoicnig - Folio Payment

Invoices can be customized according to the hotel styleguide. All invoices are handled as 
"Microsoft Word" files and can be printed on a standard hotel printer.

Figure 2-10 Hotel Invoice
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2.8 General Account

Charges that are not accounted to a guest are kept as General Account. This charge list can 
be viewed via the menu Front Office > General Account…

Similarly to the charges to be settled by the guest, also the amounts included in the General 
Account list can be deleted or printed, as described in Section 2.7, “Charge List”. As described 
in Section 2.7, “Charge List”, also the printout of the General Account list contains an invoice 
number (from Number field) and remarks (from Remarks area), if necessary, and the volume 
of the printout can be influenced by means of the checkbox Detailed charge list.

If charges from the General Account list are deleted, they will no longer be displayed in any 
described other charge list.

Figure 2-11 General Account
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2.9 Event Calendar

In the upper part of the Room Grid you have the option to enter events (holidays, vacations, 
trade fairs, etc.), which make it possible for the receptionist to keep track of these events.

To display the event calendar, Events in the View menu has to be checked.

Figure 2-12 Event Calendar

Entries in this part are made in the same way as reservation entries in the lower part by clicking 
and drawing with the mouse. The context menu New Event ... will be displayed and after 
selection of this menu item the New Event window will open. Here the name, the event type 
and the duration of the event can be entered (the duration has already been selected by 
drawing with the mouse).

Figure 2-13 New Event

There are two different types of events: Event (displayed as blue bar) and Season (displayed 
as violet bar).

Existing entries can be changed via the context menu Edit Event... or deleted via Delete Event. 

2.10 Room Availability

At the lower part of the Room Grid an area shows the total available (vacant) rooms at the 
respective time. Here you can see the number of available rooms for each day.
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Figure 2-14 Room Availability

This view is only displayed if Room Availability is checked in the View menu.

2.11 Wakeup Calls

For a checked-in guest wakeup calls can be set. To edit wakeup calls for a guest, the respective 
bar has to be selected in the respective room at the current time. The current time is always 
highlighted by a yellow bar.

In the context menu displayed afterwards select the menu item Wakeup Calls… The Wakeup 
Calls dialog for the respective room will be displayed.

Figure 2-15 Wakeup Calls Dialog

Alternatively, this context menu can also be accessed via the Wakeup Call column of the 
requested room.

The latest wakeup call status is displayed here. Only one  wakeup call can be created! If the 
wakeup call is set directly on the phone (see Chapter 6, “Telephone Interfaces”), this will 
override the wakeup call set here via the HSC Entry Room Grid.
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If you want to add a wakeup call, enter the time and press the Add button. When the wakeup 
time is entered, it is not possible to enter a date. The wakeup call will always be executed at 
the "next time possible".
Optionally, the box Daily can be checked. In this case the wakeup call will be executed every 
day for the duration of the planned stay at the time specified.

If a wakeup call has been set for the current guest, this will be displayed also in the Wakeup 
Call column of the Room Grid. At the time of the wakeup call either a simple (monitored) call is 
performed or, optionally, an additional time announcement will be made, depending on the 
configuration.

You will need an S0 card or VoIP connectivity to the system for playing the time announcement 
(see Service Manual).

If the call is not answered, another call will be made after a short time. If the call still is not 
answered, the wakeup call will be indicated as failed. For an overview of past wakeup calls, 
see the wakeup call list (see Section 3.2.6, “Wakeup Call List”).

2.12 Do Not Disturb (DND)

For a checked-in guest "Do not disturb" may be activated or deactivated.  If "Do not disturb" is 
activated, incoming calls are not put through to the room telephone. "Do not disturb" has no 
impact on outgoing calls. The current status of a room is always represented in the DND 
column.

In order to activate "Do not disturb", the respective bar in the Room Grid has to be selected in 
the correct room at the current time. The current time is always highlighted by a yellow bar.

Wakeup call set.

Wakeup call failed.

7
If the occupation of a room is extended at a later time (i.e. after setting of the wakeup 
call), daily wakeup calls for this room will not be adjusted automatically. This means 
that in this case wakeup calls have to be set anew!

"Do no disturb" actived.
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Alternatively, this context menu can also be accessed via the DND column of the requested 
room.

In the context menu displayed afterwards the menu item Turn DND on for Room has to be 
selected. Then an icon is displayed in the DND column displaying the activated "Do not disturb" 
feature. "Do not disturb" remains active until deactivation or until check-out of the guest.

In order to deactivate an activated "Do not disturb" feature, the same bar has to be selected in 
the DND column and the context menu Turn DND off for Room has to be selected.

2.13 Lock of Call Authorization and Internet Access

Call authorization for telephone calls via a trunk line and authorization for Internet access can 
be controlled directly at the Lock column in the in the context menu Turn Lock on for Room and 
Turn Lock off for Room.

The current authorization will always be indicated in the Lock column. 

2.14 Messages

It is possible to leave messages for a room from HSC. To record a message select the 
respective occupation bar in the Room Grid and the context menu Messages…

Call authorization off.

Call authorization on.
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Figure 2-16 Message Dialog

In the message dialog new messages can be added or existing can be deleted. If new 
messages are available, this is displayed in the Messages column in the Room Grid.

In addition a lamp at the guest telephone lights indicating that a message exists that has not 
been read yet. If the respective key on the phone is pressed, the guest will be connected with 
the reception and the respective message will be read to him or her. If all messages have been 
listened to, the message lamp on the guest telephone will stopp lighting.

2.15 Room Status

The status of a room can be changed to Cleaned or Uncleaned directly in the Room Status 
column of the Room Grid. 

Depending on the adequate configuration of the night run the room status of all occupied rooms 
will be set to Uncleaned every night. 

An unread message exists.

All messages are marked as "read".
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2.16 Arrival List

The arrival list can either be opened via the toolbar of via the menu Front Office > Arrival List...

The arrival list contains all guests that are expected to arrive the current day. It is possible to 
sort the list by clicking on one of the columns in the header of the table to make it easier to find 
a person. If several people are to be checked in in one go, you can also select these guests by 
multiple selection (selection with SHIFT key, selection with CRTL key or by drawing with the 
mouse). 

Figure 2-17 Arrival List

Room status Cleaned.

Room status Uncleaned.

Arrival list.
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If all requested guests have been selected, they can be checked in by selecting Check-in 
Selected (see Section 2.5.1, “Check-in after Reservation”).

In the arrival list most operations that are possible also in the Room Grid can be performed.

Reservations can be modified by Edit. 

By using Delete you can remove all reservations.

By using the Print function you can print the arrival list quickly and conveniently as a report.
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2.17 Departure List

The departure list can either be opened via the toolbar of via the menu Front Office > Departure 
List...

The departure list contains all checked-in guests that are leaving on the current day. It is 
possible to sort the list by clicking on one of the columns in the header of the table to make it 
easier to find a person. If several people are to be checked out in one go, you can also select 
these guests by multiple selection (selection with SHIFT key, selection with CRTL key or by 
drawing with the mouse).

Figure 2-18 Departure List

If all requested guests have been selected, they can be checked out by selecting Check-out 
Selected (see Section 2.6, “Check-out”).

You can change an occupation by selecting with the mouse and clicking the Edit button.

By using the Print function you can print the departure list quickly and conveniently as a report.

Departure list.
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3 Reports

HSC can generate a number of work lists making it easier for your staff to keep track of the 
activities to be performed. All work lists have the same set-up and only differ in the options of 
search entries.

The menu Reports offers the option

● to create one of four work lists available for the current time by direct selection or

● to define filter criteria concerning the data to be output in the lists and/or to create two 
additional work lists by means of the menu item Work List Selection...

Meaning of the menu items

● Arrival Report...
generates a list of all guests who will arrive today (see Section 3.2.1, “Arrival Report”)

● Departure Report...
generates a list of all guests who will depart today (see Section 3.2.2, “Departure Report”)

● In-house Report...
generates a list of all guests for which you have an active booking today (see Section 3.2.3, 
“In-house Report”)

● Room Status List...
generates a list of all rooms and their current status (see Section 3.2.4, “Room Status List”)

● Work List Selection...
Here you can select the time interval and, if applicable, further filter criteria that your list is 
to consider; besides, two additional work lists can be selected (see Figure 3-1).

The first four menu items lead directly to the report; no additional specifications are necessary 
or possible.

In Work List Selection you can enter some parameters (e.g. time interval) and also select the 
list type required.

Let's have a closer look.
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3.1 Work List and Parameter Selection, Report Struct ure

Figure 3-1 Work List Selection Window

The Work List Selection window is divided into the following areas:

● Selection area (see Section 3.1.1, “Selection Area”)

● Parameter entry area (see Section 3.1.2, “Parameter Entry Area”)

● Display area (see Section 3.1.3, “Display Area”)
(If you open the respective work list directly by means of the menu item Arrival Report..., 
Departure Report..., In-house Report... or Room Status List... only this window area will be 
visible.)

● Control area (see Section 3.1.4, “Control Area”)

After you have selected the requested work list and entered the requested parameters, you can 
initiate the display of the list in the view sector by using the View button in the control sector. 
Directly above your list you will find a navigation bar (see Section 3.1.3.2, “Navigation Bar”) you 
can use for browsing the list, changing the size of the list and printing out and saving the list.
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3.1.1 Selection Area

In the selection area you can indicate which work lists you wish to create.

Figure 3-2 Work Lists - Existing Types

The following types of work lists are offered:

● The Arrival List shows all guests that are expected to arrive at a period to be specified (see 
Section 3.2.1, “Arrival Report”). 

● The Departure List shows all guests that are expected to depart at a period to be specified 
(see Section 3.2.2, “Departure Report”). 

● The In-house List shows all guests that are currently checked in (see Section 3.2.3, “In-
house Report”). 

● The Room Status List shows the current cleaning status of all rooms.  Optionally, only a 
list of the rooms yet to be cleaned can be generated (see Section 3.2.4, “Room Status 
List”). 

● With the Charge List you can report all charges for a number of rooms for a freely 
selectable period (see Section 3.2.5, “Charge List”).

● The Wakeup Call List contains a list of wakeup calls and their statuses ("executed" / "failed" 
…) (siehe Section 3.2.6, “Wakeup Call List”).

3.1.2 Parameter Entry Area

In this area you can enter search criteria that shall be used for the generation of the work list.  
The criteria that can be entered depend on the work list selected. Whenever a date is entered, 
its format is shown as a tooltip (format depends on the local settings in the Windows operating 
system). 
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3.1.3 Display Area

3.1.3.1 Structure of a Work List

The work lists are displayed using a JasperReports Viewer.  

A report (i.e. a work list) consists of

● the report header and

● the table part

and, by means of the navigation bar of the JasperReports Viewer (see Section 3.1.3.2, 
“Navigation Bar”), it can be stored, printed or its size can be changed, for example.

Report header

The parameters selected in the parameter entry area are displayed in the report header.

Figure 3-3 Work Lists - Report Header Example

Table part

The actual report output area always is organized as a table.

Output is performed in accordance with the selected parameters in the parameter entry area.

3.1.3.2 Navigation Bar

Figure 3-4 Work Lists - Navigation Bar in Reports

>
If you open the respective work list directly by means of the menu item Arrival 
Report..., Departure Report..., In-house Report... or Room Status List... only this 
window area will be visible.
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Using the navigation bar you can perform the following actions with the displayed report:

Store the report in a file of selectable format (e.g. PDF, XML, …)

Print the report on a selectable printer

Update the report presentation (not relevant at HSC and therefore not 
available)

Display the first page of the report

Go to the previous page in the report

Go to the next page in the report

Go to the last page of the report

Go to the entered page xx in the report

Display report in the current size

Align report presentation to page height

Align report presentation to page width

Enhance the zoom factor of the report in steps

Minimize the zoom factor of the report in steps

Display the report in the selected zoom factor
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3.1.4 Control Area

In the control area you will find all buttons for performing the required actions.

Starts the creation of the defined service request list and displays it on the screen in the 
form that you have set (above) in the Parameter Input window area: 

● View - List is displayed to the right in the Report window area. 

● View maximized - List fills the entire Work Lists window; the Type Selection and 
Parameter Input window areas are covered in this process.

● View in new window - List is displayed in a newly opened Report Presentation window; 
this has no effect on the contents of the Work Order Lists window as well as already 
existing other Report Presentation windows.

Resets the parameters for the selected list type to the values that existed when the window 
was opened.

Hides the Type Selection and Parameter Input window areas in the Work Lists window and 
displays the currently visible list making use of the full width of the window (corresponds 
with the display type View maximized, see above).

Displays - in the maximized list presentation (View maximized) - the Type Selection and 
the Parameter Input window areas in the Work Lists screen, thus minimizing the screen 
width of the currently displayed list (corresponds with the display type View, see above).

Closes the window.

> In the display type View in new window several different lists can be visible on 
the screen at the same time!
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3.2 Description of the Work List Types

For a detailed description of the general structure of all lists mentioned below, see Section 
3.1.3, “Display Area”.

3.2.1 Arrival Report

This list shows you which guests are expected at what period. The current date is preset as 
search criterion.

Figure 3-5 Entry of Parameters for the Arrival Report

The settings in the above figure will display all guests arriving on 13-08-2008.

3.2.2 Departure Report

This list shows you which guests are expected to check out at what period. The current date is 
preset as search criterion.

Figure 3-6 Entry of Parameters for the Departure Report

The settings in the above figure will display all guests departing on 13-08-2008.

3.2.3 In-house Report

The in-house report shows you which guests are checked in at the current time.  Here no 
additional search entries are required.

3.2.4 Room Status List

The Room Status List allows you to give a list to your staff which they can use for cleaning the 
rooms and for checking on it. 
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Figure 3-7 Entry of Parameters for the Room Status List

You can select whether you want to generate the list for all rooms or only for rooms in a certain 
status(e.g. "Uncleaned"). The latter option will be the default setting when launched next.

In addition, you can specify whether the list is to be sorted by status or by room number.

3.2.5 Charge List

You can use this dialog to initiate the creation a report that collects the charges of various hotel 
services into one list.

Figure 3-8 Entry of Parameters for the Charge List

You can enter the period for which you want to view the accrued charges. You can also specify 
whether you want to know the charges of a specific room or of all rooms. 

In Type of charge please select whether you want to view the telephone charges or the Internet 
charges or both.

For privacy reasons the last 3 digits of the telephone number will not be displayed (there will 
be "XXX" instead). However, if you want to view the complete numbers, check the checkbox 
Display full numbers.

You may also select whether all taxes should be included in the charges or whether net 
charges should be displayed.
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In HSC you can also group the items displayed by room, date or charge type. You can sort the 
items by date or price.

3.2.6 Wakeup Call List

In this report you can see which wakeup calls have been executed successfully, which have to 
be executed in the future and which have failed.

Figure 3-9 Entry of Parameters for the Wakeup Call List

You can view all wakeup calls for a requested period of time.

In addition, you can limit the output to wakeup calls in a specific status. In HSC the following 
statuses are available:

● Set
these wakeup calls have been set by the guest but not yet executed

● Submitted
these wakeup calls have been set by the guest, have not been executed yet, however have 
already been submitted to the wakeup call system

● OK
these wakeup calls were executed successfully

● No answer
these wakeup calls were not accepted by the guest

● Busy
the telephone of the guest was busy at the time of these wakeup calls (wakeup calls are 
registered as successful)

● Unsuccessful
these wakeup calls could not be executed (reason unknown)

● Error
these wakeup calls could not be executed because of an internal error

● No answer/Ack.
these wakeup calls were not accepted by the guest; however, these wakeup calls have 
been already deleted at the HSC GUI (see Section 2.11, “Wakeup Calls”)
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● Busy/Ack.
the telephone of the guest was busy at the time of these wakeup calls (wakeup calls are 
registered as successful); however, these wakeup calls have been already deleted at the 
HSC GUI (see Section 2.11, “Wakeup Calls”)

● Unsuccessful/Ack.
these wakeup calls could not be executed (reason unknown); however, these wakeup calls 
have been already deleted at the HSC GUI (see Section 2.11, “Wakeup Calls”)

● Error/Ack.
these wakeup calls could not be executed because of an internal error; however, these 
wakeup calls have been already deleted at the HSC GUI (see Section 2.11, “Wakeup 
Calls”)
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4 HSC Front Office Basic Functions

4.1 HSC Main Desktop

After logging in, the HSC main desktop is displayed on your screen, which consists of two 
areas: 

● the navigation area with the menu bar and the toolbar and 

● the working area.

Figure 4-1 HSC Entry Main Desktop

Navigation Area

Immediately below the header of the HSC main desktop you will find the menu bar, comprising 
the menus General, View, Front Office, Reports, Administration, Window and Help.
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Figure 4-2 HSC Menu Bar (with Displayed Menu)

Below the menu bar you will find the toolbar, where you can directly access the most frequently 
used HSC functions by clicking on the icons.

The menus General, View, Window and Help will be explained in Section 4.2, “Basic 
Functions”. 

The functions of the menus Front Office and Report will be explained in Chapter 2, “Room Grid” 
and Chapter 3, “Reports”.

You will find information on the Administration menu in the Service Manual.

Figure 4-3 HSC Toolbar (with HSC Logo on the Leftmost Side)

The functions that can be launched via the menu bar or the toolbar are described - depending 
on the target group - either in the corresponding chapters of this manual or in the HSC Service 
Manual.

The following quick access options are offered:

● Access to the Room Grid (see Chapter 2, “Room Grid”)

● Entry of a new reservation (see Section 2.2, “Reservation for Individuals”)

● Entry of a new group reservation (see Section 2.3, “Group Reservation”)

● Access to today's arrival list (see Section 2.16, “Arrival List”)

● Access to today's departure list (see Section 2.17, “Departure List”)

● Access to the work lists (see Chapter 3, “Reports”)

> As soon as you move the mouse cursor on an icon (without additional text), a tooltip 
explaining the icon’s meaning is displayed.
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Working Area

The working area is located beneath the navigation area.

Upon your login, the previous status of the working area is resumed, i.e. the windows you left 
open when you exited the previous session will be re-opened in the previously used size and 
position.

Upon the first login, the Room Grid can be immediately viewed in the working area (see 
Chapter 2, “Room Grid”).

4.2 Basic Functions

This chapter describes the basic functions of HSC Front Office, such as how to deal with 
windows or how to use the online help.
These basic functions can be found in the menus General, View, Window and Help.

With the items in the General menu  described below you can show/hide the message area 
and log off from the HSC system.

Figure 4-4 Menu Items in "General"

System Messages...

Upon activation of this menu item, messages are output as a table in a separate window. 
The structure of the message window is explained in Section 4.3.

Logout

Used for logging out from the HSC Entry application.
By entering your user data you can log on to the system again.

Exit

This will exit your HSC Entry application.
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In the View menu  you may select which parts of the Room Grid should be displayed.

Figure 4-5 Fig 4-4 Menu Items in "View"

If you display Events, you can see which events will take place on which days. If you select 
this view, fewer rooms may be displayed in the Room Grid, depending on the size of the hotel.

In the Room Availability view you can see whether rooms are available on specific days.

Apart from the buttons (1 day, 1 week, 1 month back and forward) you have another option for 
selecting a specific period in the Room Grid by using Timeline Scrollbar.

The Window menu  helps you to manage the HSC windows currently opened. 

Figure 4-6 Menu Items in "Window" (When two HSC Windows are Currently Open)

Cascade

Moves all open HSC windows on the desktop so that they are organized as a cascade.

Close All

Closes all HSC windows currently opened.

<window title>

The titles of all currently open HSC windows are listed in the Window menu as separate 
menu items. By clicking the requested window title the focus is put on this window.

The Help menu  supplies you with information on the currently installed HSC software version 
and makes access to the start page of the online help.
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Figure 4-7 Menu Items in "Help"

About...

Opens the About window, where the version of the entire system as well as the HSC 
components graphical user interface, database and core are entered and the latest hot 
fixes are listed.

Figure 4-8 About Window

Clicking the links Detailed module versions... and http://www.pse.si/en/hospitality you get 
to the Status Overview and get information on the PSE Hotel Portal. 

Help

Opens a browser window and displays the start page of the HSC-specific online help in 
HTML format. You can navigate to the individual chapters of the HSC User Guide or the 
HSC Service Manual by using the table of contents, the index or the search function. For 
more details on the online help see Section 4.4.
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4.3 Message Window

You can display the messages output by HSC Entry in a separate window on your desktop.
For showing the message window you can use the menu item System Messages in the 
General menu.

In this area messages referring to the HSC Entry system are displayed. However, these 
messages do not have direct impact on the system. Therefore you do not have to solve 
potential problems at once. The messages are only meant for your information (and are not 
saved in the HSC database).

The messages are output as a table with four columns - Received, Priority, Type and Text.
If required, use the scroll bar to be able to view all messages.

You can use the button Clear to remove all messages currently displayed in the message 
window.
By means of the button Close you can hide the message window.

Figure 4-9 Message Window Containing Messages

4.4 Online Help

The HSC system offers embeded pdf documentation.

If you press F1 within a HSC window, the HSC system will open a browser window with links 
to user/service/administrator documentation.
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5 Service Tracking

Service Tracking ensures that both service requests of hotel guests and other work orders are 
collected and submitted to responsible hotel staff members. Moreover, you can follow the 
service progress from a central point.
The basic functioning of Service Tracking in HSC is described in more detail in the 
Administration Manual, Chapter 5.

This chapter provides a detailed description of the user interfaces for Service Tracking in the 
HSC system:

● Menu Service Tracking in the Front Office navigation area of the HSC system with the 
menu items New Service Request and Service Control (see Section 5.1)

● PDA device and its functions (see Section 5.2)

5.1 Service Tracking - Front Office Client

By means of the Service Tracking menu in the menu bar of the HSC main screen you can 
request a new service and track the progress of service request completion:

● To reach the Service Request window, please click the menu item New Service Request 
(see Section 5.1.1).

● To access the Service Control window, click the menu item Service Control (see Section 
5.1.2).

> Using functions described below requires a license for "Service Tracking".

>
To make it possible for you to use the features of Service Tracking, your hotel 
administrator must have made specific settings at the configuration of HSC. Please 
refer to the Administration Manual, Chapter 5, for further information.
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5.1.1 New Service Request

With the New Service Request window you can create a new service request for a guest 
staying in your hotel or enter other work orders. You can assign the service to a service 
attendant (or a category) and describe the service type as well as the time when the service 
should be performed and whether it is a periodical service.

There are several options for opening this window:

● Click the New Service Request item of the Service Tracking menu or

● click the New Service Request... button in the Call Control Center window (see Section 
4.1) or 

● click Edit... or Copy... in the button bar of the Service Control window (see Section 
5.1.2), after having selected a request in the service request list of this window.
If you use the function Edit Service Request after selecting Edit… you can send a 
reminder to the responsible service attendant or note down information of the solution 
as well as feedback and satisfaction level of the guest related to the (performed) 
request.
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Figure 5-1 Window for First Creating, Editing or Copying of a Service Request

The Service Request window consists of the following areas:

● A toolbar with the buttons Save & Submit, Save, Print and Delete, as well as buttons 
for showing/hiding further window areas (see Section 5.1.1.6).  

● Input/output area Initiator (see Section 5.1.1.1)

● Input area Basic Information with Reset button (see Section 5.1.1.2). 

● Input/output area Advanced Information (see Section 5.1.1.3)

● Input area Scheduling (see Section 5.1.1.5)

● Input/output area Actions with additional buttons (see Section 5.1.1.4).
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5.1.1.1 Initiator

In this area you specify the person who has requested the service.

If you open the New Service Request window from the Call Control Center while a guest 
checked in at your hotel calls, the Initiator area is automatically filled in with the caller's details.

Otherwise you can define the initiator of the service request, by

> entering a surname or a first name or a room number either directly in the Initiator field, 
which immediately displays a drop-down list with all persons matching your entry, from 
which you then select the initiator ("quick search") 

> or activating the function Advanced Search… by pressing the associated button (see 
below). 

Figure 5-2 New Service Request - Initiator Area (with "Quick Search" for Names)

Initiator

Entry and selection field for defining the initiator of a service request.

As soon as you enter a first name or a surname as a search criterion (i.e. at least its first 
character), a drop-down list will be opened, in which all hotel employees of this name and 
all guests of this name that are currently staying at your hotel, are displayed.
As soon as you enter a room number as a search criterion (or at least its first digit), a drop-
down list will be opened, in which all hotel employees assigned to this room and all guests 
assigned to this room that are currently staying at your hotel, are displayed.

The titles, surnames, first names, languages, VIP statuses, and room numbers of the 
persons included in the list will be displayed.

If the drop-down list includes more than one person after your entry, you can select the 
right person for initiating a service request by mouse click. 

>
Only the toolbar, the input and selection field Initiator and the window area Basic 
Information are always visible in the Service Request window; you can show or hide 
all other window areas as required using the buttons in the toolbar.
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Makes possible an advanced initiator search by means of several interlinked filter criteria, 
including guests who stayed at your hotel at an earlier time

Advanced Search

If it is not possible for you to simply identify the initiator of the service request by entering a first 
name or a surname or a room number (see above) and he is not entered automatically by the 
system (e.g. as name of a caller), you can search for this initiator, using this extra function and 
several, interlinked criteria, and even include guests who have stayed at your hotel before.
It is not allowed  to use wildcards (*, %, etc.) in this search function!

Once you press the Search button after having defined the search criterion, the values entered 
by you are logically linked with "AND". The Search result is displayed in the list where you 
select an entry by means of the Select button or directly by double-clicking on the entry.

If you press the Close button, you can leave the window without making a selection. 

Figure 5-3 Window for the Definition of the Search Criterion

Source

Select the data area, where you want to search for the person who has initiated the service 
request: 

● Guest - the data area with the guests currently checked in at your hotel

● Guest profile - the data area of all persons who have ever been guests of your hotel
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● Employee - data area with hotel employees

Name

Selection criterion for initiator search (as a Source any selection is possible)

Room

Selection criterion for initiator search; relevant for guests that are currently staying at your 
hotel or were staying at your hotel previously (then earlier room numbers can be used as 
search criterion!) or for hotel employees (i.e. as a Source any selection is possible). 

Extension

Selection criterion for initiator search; relevant only for guests currently staying at your 
hotel or for hotel employees (i.e. if Guest or Employee has been selected as a Source).
In case of several guests with the same name, use the Extension field to differentiate.

Search result

Multiline list of all persons meeting the search criteria entered and interlinked by the logic 
operator "AND" (in the title bar of the list the "hits" are shown). 

– 1. line: salutation, title (if applicable), surname, first name, language, VIP status; icon 
indicating the data area assignment

– Further lines: Information on in which room and when the person has stayed at the 
hotel before or is currently staying

5.1.1.2 Window Area Basic Information

With this area you define the requested service.

The entries in the numerous drop-down lists in this area are always sorted in ascending or 
alphabetical order.

Figure 5-4 New Service Request - Area Basic Information
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Location

Usually filled automatically with the number of the room that is assigned to the initiator of 
the service request (if available; see also Section 5.1.1.1).
Please check the entry and, if necessary, select the location where the requested service 
should actually be performed (corridor, kitchen, etc.).

Service type

Select the type of the service request, e.g:

● positive - all common services, e.g. bringing towels or shampoo toan individual room

● negative - some repairs

● comment - comments regarding the service request

● complaint - complaints regarding a service request

Service code, Service text

Select either the Service code or the Service text and check the entry in the other drop-
down list. If you enter any number of leading characters of a service text or code, in the 
Service text or Service code field, only those service texts or codes will be offered for 
selection, which include the specified characters.

If you enter any number of leading characters of a service text or code, in the Text or Code 
field only those service texts or codes are offered for selection which include the specified 
characters.

Details

If required enter details on the service request (e.g. the latest-possible date of service 
execution, special requests of the guest, …).

By means of the following three drop-down lists you assign the service to a responsible 
department, a category and/or a service attendant. The corresponding entries for the drop-
down lists are selected automatically by the system after you have entered the service code or 
the service text. Select the required entries.

>
Which service types you can choose from depends on the configuration of 
Service Tracking in your HSC system (see Administration Manual, Chapter 5).  
Here examples of the service types available by default after the first installation 
of a HSC system are listed.

> Service type, Service text and Location are obligatory fields!
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.Department

If necessary, modify the department the service has been assigned to.

Category

If necessary, modify the assigned category.

Service attendant

If necessary, modify the service attendant the service has been assigned to. The service 
attendants’ status is indicated by the icon next to his/her name:

Figure 5-5 New Service Request - Indication of the Status of the Service Attendants 
in the Drop-Down List

>
You may not be able to change the corresponding entries in this area if there is 
only one department/category/service attendant responsible for the specified 
service. Otherwise all responsible departments/categories/service attendants 
are offered for selection.

The service attendant is in; you can assign the service request to him/her.

The service attendant is out.

The service attendant is on break. If the service need not be performed 
immediately, you can still assign it to this service attendant.

No service assistent is selected; the search function is active. Enter the first 
character(s) of a service assistant’s name and press <Enter> to start searching 
for the service attendant.
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Figure 5-6 New Service Request - Selection Option for Service Request to Category

Transmission route

Enter the way the service attendant is informed about the new service request (e.g. PDA, 
CMI, OpenStage, SMS, e-mail).

Resets - except for Location and Details - all fields of the window area Basic Information 
to the original values (of the time when the window was opened). 

5.1.1.3 Window Area Advanced Information

In this window area you an enter feedback messages after the completion of the service 
request.
For this purpose you usually select the service request in the Service Control window, as soon 
as it is in the Done status, and then reopen the window described here by clicking the Edit... 
button (see also Section 5.1.2.1 and Section 5.1.2.2).

Figure 5-7 New Service Request - Area Advanced Information

>
If you do not want to specify the service attendant, you can supply the request 
as "Category Request" (see Figure 5-6) - provided that such an option has been 
configured for the selected category (see Administration Manual, Chapter 5).
Service requests supplied as "Category Request" can be viewed, accepted and 
performed by all service attendants of the selected category.
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Solution

Enter additional comments after  the service has been performed.

Satisfaction level

Select one of the offered levels to indicate the guest's satisfaction with the service.

Feedback

If required enter a verbal comment on the selected level of satisfaction.

5.1.1.4 Window Area Scheduling

With this area you specify the time a service request that has been confirmed by means of Save 
& Submit will be submitted to the defined service attendant.

Figure 5-8 New Service Request - Scheduling Area

Now

Check it, if the service request shall be submitted immediately after you confirm the service 
request with the Save & Submit button. The Date and Time fields become read-only fields 
with the current date and time.

>
Which and how many service satisfaction levels you can choose from depends 
on the configuration of Service Tracking in your HSC system (see 
Administration Manual, Chapter 5).

> If the service request is confirmed by means of the Save button the entries in the 
area Scheduling are not relevant.

7
The Scheduling area specifies only the time of submitting the service request, 
not the time when the service should be performed. If it is necessary to perform 
the service immediately (or at a specified time), enter this information into the 
Details field in the Basic Information area (see Section 5.1.1.2)!
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Do not check it, if the service request shall be submitted as specified with the Date and 
Time fields.

Daily

Check it, if the service request shall be submitted periodically on the days you select in the 
checkboxes below until the date specified in the Until field.
After checking it, the read-only field Until becomes active and the date-picker icon is dis-
played next to it.

Do not check it, if the service shall be performed only once.

Date

Enter the date when the service request shall be submitted. The default value is the current 
date.

Time

Enter the time when the service request shall be submitted. The default value is the current 
time.

Until

Becomes available after you check the Daily checkbox (otherwise read-only field). Enter 
the end date of submitting the service (use the date-picker or the format dd.mm.yyyy).

Mo, Tu, We, Thu, Fr, Sa, Su

Represent weekdays, become available if you check the Daily checkbox (otherwise read-
only fields). Check the days on which the service shall be performed.

● To have the service performed now, check the Now checkbox. The Date and Time fields 
become read-only fields and the service will be submitted to the service attendant as soon 
as you confirm the New Service Request by clicking the Save & Submit button in the button 
bar.

● To have the service performed daily, check the Daily checkbox. The Until field and the 
weekdays checkboxes become active for you to specify, until when and on which days the 
service is to be performed. Upon clicking the Daily checkbox, the Until field becomes an 
obligatory field. For filling it in use the date-picker icon displayed upon checking Daily or 
the format dd.mm.yyyy.

● To have the service performed now and from now on periodically, check both checkboxes 
and set the periodicity.

● To have the service performed on a specified day and time, fill in the Date and Time boxes 
and confirm the New Service Request by clicking the Save & Submit button.
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5.1.1.5 Window Area Actions

This area is used for displaying the service request number and the creator of the service 
request and makes it possible to change the service request status, if required.

Figure 5-9 New Service Request - Actions Area

Service request No.

Read-only field; displays the internal number of the service request. This number is 
generated automatically by the HSC system.

Creator

Read-only field, shows the creator of the service request (as a rule a front office employee)

Service request status

Shows the current service request status, which you can also change, if required (see the 
note in Section 5.1.1.6).

Notification with ringing

If you have selected "CMI" or "OpenStage" as a transmission route for the service request, 
you can define by checking this box that the alerting of the service attendant is performed 
both by displaying an envelope icon (CMI) / by lighting up of a LED (OpenStage) and with 
a ring tone.
If the box has not been checked, no ring tone will be sent for alerting the service attendant. 

> This is the only service request parameter that can be modified before the 
Remind function will be performed (see Section 5.1.1.6).
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5.1.1.6 Buttons

Buttons in the window area Actions

Transmits a reminder to the service attendant to whom the service request that is currently 
displayed in the window New Service Request has been assigned.
The respective service request must have been created already at an earlier time and still 
be open. It then has to be selected in the window Service Control and displayed again by 
means of the Edit… button in the window New Service Request.
If the service request has already been accepted, the service attendant who has been 
reminded does not have to accept it again.

Closes the window without any changes.

Buttons in the toolbar

Creates the new service request, saves and submits it (including explicit notification) to the 
service attendant that has been assigned to it at the time configured in the window area 
Scheduling (for details on how to use this button see "Notes").

Creates the new service request and saves it immediately without notification  of the 
assigned service attendant (for details on how to use this button see "Notes").

Outputs the data of the new service request on the printer selected in the printer selection 
dialog.

>
Neither the service request status nor the "counter" (configurable time 
period until the service request has been accepted or completed) are 
influenced by the reminder function.
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With Delete you can delete a service request.
This button is only visible if you are authorized to delete service requests (for assignment 
of the respective rights, see Administration Manual, Chapter 4).

With these three buttons you can show and/or hide one of the window areas Advanced 
Information, Scheduling and Actions.
In doing so you can reduce the window size by those window sections, where you usually 
do not make any changes, and thus create space for other important windows on your HSC 
main screen.

Notes on how to use the buttons "Send & Submit" and  "Save"

When creating and/or editing a service request you can decide whether you just want to save 
the request (Save button) or save and submit it to the assigned service attendant with explicit 
notification (e.g. ringing, lighting up of a LED) (Save & Submit button). 

Service requests confirmed with Save & Submit are submitted in accordance with the 
transmission route selected and what has been selected in the Scheduling area, the assigned 
service attendant is explicitly notified; the service requests are initially saved in the request 
status Created, their request status changes to Submitted as soon as they have been 
submitted.

By means of Save service requests that are in the status Created are changed automatically 
to the status Submitted, however, the assigned service attendant is not notified explicitly (i.e. 
the selected transmission route is not used). If you have set in the window New Service 
Request another status for a service request to be saved  (e.g. Prepared or Done) this status 
will not  be changed when Save is pressed. 

>
You can only print a service request if you have saved it before by means of 
Save or Save & Submit.
Printing of a service request list can be done via the Work Order Lists menu (see 
Section 6.2).
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Also service requests that have been changed from the status Created to the status Submitted 
by means of Save, can be viewed (and in certain cases also edited) by the responsible service 
attendants by means of their PDAs, OpenStages or CMIs.

In a hotel information on service requests to be performed is sometimes given on an informal 
level and need not be explicitly sent to service attendants. In such cases the function Save 
makes it possible to collect service requests so that they can be put together and may be 
transmitted in hardcopy later on.
If a service request is to be prepared for later editing, please select the request status Prepared 
when creating the request.
Also service requests that have been completed without Service Tracking support can be 
entered into the list of service requests at a later time by means of Save - after selection of the 
status Done - to make it possible for the hotel to have seamless documentation and statistics.

5.1.2 Service Control

With the Service Control window you can view and edit requested services. The color 
differentiation offers you a better overview upon the recognition of the status of individual 
requests and thus makes daily work easier for you.
Click the menu item Service Control in the Service Tracking menu to open this window.

By clicking the respective link you can choose between three variants of the displayed service 
request list:

● Service request filtering list (displayed by default when the window is opened)

● Search result list

● List of service requests relevant for Call Control (displayed if a guest calls to whom at 
least one service request is assigned)

Basically the Service Control window consists of the following areas:

● Toolbar with buttons (see Section 5.1.2.2)

● "Filter Area" in two variants, as required

● List of service requests (see Section 5.1.2.1)

Service Request Filtering List

You can choose in the filter area  above the list which category of service requests you want 
to see by activating/deactivating the respective checkboxes. 
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● On the left side you can individually select all service types configured by your hotel 
administrator (see Administration Manual, Chapter 5),

● on the right side you can individually select the service request statuses (only relevant as 
filter criterion for service types that are "submittable" (see Administration Manual, Chapter 
5).

In the list  all service requests corresponding to the respective filter criterion are displayed.

Figure 5-10 Service Control - Service Request Filtering List

Search Result List

In this list you can define suitable search criteria via the input fields Room, Initiator and/or 
Service attendant.

After pressing the Search button (or terminating your entry with <Enter>) your entries will be 
linked with the logic operator "AND" and the search result is presented in list form. 

Upon first opening this list will be empty. After changing to this list later on - before the entry of 
a new search criterion - the latest entries are displayed again.
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Figure 5-11 Service Control - Search Result List

Room

Input of the number of the room to which the service requests searched for are assigned.

Initiator

Input of the initiator that has initiated the requests searched for.

Service attendant

Input of the name of the service attendant to whom the service requests searched for are 
assigned.

List of Call-Relevant Service Requests

This list is filled with entries only if the Service Control window is open while a call from a hotel 
guest is answered for whom once at a time a service request has been performed. The HSC 
system will then, based on the extension number of the caller, know the name of the caller, the 
room in which the guest stays, as well as all other persons who may stay in this room, as well 
as all service attendants connected with this extension.

All of these data are used as filter criteria for the service requests displayed in the list; you 
therefore see all open  requests

● assigned to the room of the caller,

● of which the calling guest or another person staying in the room of this guest is the initiator,

● for the service attendants connected with the extension of the calling guest.
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Figure 5-12 Service Control - Call-Relevant List

5.1.2.1 List of Service Requests

In each of the three variants this list contains the respective service requests with the following 
details.

New services requests initiated either by Front Office employees (see Section 5.1.1) or by serv-
ice attendants (see Section 5.2) or by Facility Monitoring (see Chapter 8) are added on the top 
of the table. In case of periodic services, a new service request for the next day is included in 
the table, once the service has been performed for the current day.

Creator

Displays the creator of the service request.

>
By default HSC is configured to make sure that HSC automatically generates the list 
when a call is received and switches to this list display (the Service Control window 
will not be displayed in the foreground during this process). Professional Services 
can configure the HSC database by a specific entry so that you yourself have to 
switch to this list view.
This list is not cleared when the associated telephone call has ended, but only 
updated automatically when a new call is made.

>
By right-clicking the mouse button somewhere in the table header you can define in 
a subsequent window (see Section 2.1, “Table”) which of the numerous service 
detail information described below are important for you and therefore should be 
visible as table columns.
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Status

Displays the service status (only relevant for service requests related to service types that 
can be submitted to service attendants, e.g. positive and negative service requests).

To change the service status, click an entry in this column and select the new status in the 
drop-down list which contains the following status types:

● Prepared - the service has been requested by a service attendant (see Section 5.2.3) 
or by Facility Monitoring (see Chapter 8).

● Created - the service has been requested, but not submitted to a service attendant yet.

● Submitted - the service has been created and submitted to a service attendant.

● Accepted - the service attendant who the service was assigned to has accepted the 
service.

● Rejected - the service attendant who the service was assigned to has rejected the 
service.

● Done - the service attendant has performed the service.

● Failed - a rejected service request is not relevant any more, because it has been 
closed by the Front Office staff.

● Special case:
Deleted - the service request is no longer relevant and is no longer displayed in 
Service Tracking, as it has been deleted by a hotel employee who is authorized to do 
so (see Administration Manual, Chapter 4).

>
In case of "unsubmittable" service types (for configuration, see Administration 
Manual, Chapter 5), the (unchangeable) service type itself will be displayed 
instead of a service status.

>
HSC distinguishes between:
Open service requests  - requests with Prepared, Created, Submitted, 
Accepted or Rejected status,
Closed service requests  - requests with Done or Failed status and
Deleted service requests  which no longer are displayed in Service Tracking.

7 Once the service status is set to Done or Failed you cannot change it any more!
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Request No.

Displays the service request number.

Room 

Displays the room number associated with the service request.

Initiator

Displays the surname, the first name and, if applicable, the title of the person who has 
requested the service.

VIP

Shows the VIP-status of the initiator (if existent).

To Do

Displays the service text and the details of the service request.

Subm. Time

Displays the date and time of submitting the service request to a service attendant.

Service Attendant

Displays the surname and the first name of the service attendant to whom the service has 
been assigned.

Resp. Category

Displays the category (= subdepartment) to which the service request has been assigned.

Last Status Modif.

Displays the date and time when the service status was changed (e.g. Accepted --> Done) 
or when any changes concerning the requested service took place (e.g. if a service 
attendant rejects a service request and the request therefore has to be submitted to 
another service attendant).

>
If a service request has been deleted by a hotel employee who is authorized to 
do so (for the assignment of rights: see Administration Manual, Chapter 4), it is 
no longer relevant for Service Tracking and will not be displayed in the Service 
Control window any longer; such service requests can only be listed by means 
of MIS reporting (report Service Tracking Quality; see Section 7.11).
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Counter

Displays the time lapsed (in minutes) since the service request was submitted to a service 
attendant. 

After the service status has changed to Submitted or Accepted, the Counter starts counting 
the time span defined for the corresponding service text (see Administration Manual, 
Chapter 5). The defined time (in minutes) is displayed as a negative whole number. When 
the Counter reaches 0, the color of the service row changes and the Counter counts on in 
positive whole numbers.

Meaning of the colors in the table rows

The following colors inform you about the service status:

● Pink - The service request has been submitted to a service attendant.

● Yellow - The service request has been accepted by a service attendant.

● Red - The service request has been rejected by a service attendant.

● Green - The service request has been done.

The following colors inform you about a timeout of service requests:

● Red - the service request could not be submitted or the service request was not done in 
time.

● Magenta - the service request was not accepted in time.

5.1.2.2 Button Bar

Edit ... opens the service request selected in the list in the Edit Service Request window. 
Edit the service details and confirm with Save & Submit or Save or send a reminder to the 
assigned service attendant by clicking Remind (see Section 5.1.1).

>
Use the Edit... button to edit service requests with the following status types: 
Prepared, Created, Submitted, Accepted, Rejected and Done.
Service requests in the Done status are generally edited to add feedback, level 
of satisfaction and/or solutions!
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Copy... creates a copy of the service request selected in the list and opens it in the Copy 
Service Request window. After you have edited the service details in this window and 
confirmed the changes with Save & Submit or Save (see Section 5.1.1), a copy is added 
as new service request on the top of the Service Control table.

Outputs the data of the selected service request from the printer selected in the printer 
selection dialog.

With Delete you can delete a service request selected in the list.
This button is only visible if you are authorized to delete service requests (for assignment 
of the respective rights, see Administration Manual, Chapter 4).

> Use the Copy... button to create new service requests.

> Printing of a service request list can be done via the Work Order Lists menu (see 
Section 6.2).
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5.2 Service Tracking - Tablet Device

The services created with Front Office are submitted to service attendants who use a Tablet 
device with the HSC system.

In the HSC system, service attendants are informed via Tablets when and what services they 
have to perform. At the same time they use Tablet devices to inform Front Office about the 
progress of the service.

5.2.1 Working with the HSC Tablet Device

With the Tablet device, you can:

● View, accept and reject services (see Section 5.2.2)

● Create new services (see Section 5.2.3)

● Set up and cancel a break (see Section 5.2.5)

● View services requested for different locations and service attendants (see Section 
5.2.4)

This chapter also describes the Tablet device login and logout.

Login

To log in, do the following steps:

1. Turn your Tablet on.

2. Browse to hotel portal
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Figure 5-13 Tablet - Displaying the Keyboard

3. Enter http:\\localhost:8270 into the navigation bar.

4. In the Launch HSC 2.6 Applications area click the Tablet Service Tracking item.
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Figure 5-14 Tablet - Login

5. Select your user name and enter your PIN.

Username

Select your user name.

PIN

Enter your PIN.

1,2,3,4,5,6,7,8,9,0

Use the digit buttons to enter your PIN.
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Opening screen

The Tablet opening screen consists of the icon bar and the working area (see Figure 5-15 
below).

Figure 5-15 Tablet Opening Screen

Username

Displays your user name.

Icons representing working screens. A red bar below the icon indicates the active screen.

>
The Tablet GUI language depends on the language(s) assigned to the service 
attendant by the administrator when configuring Service Tracking (see 
Administration Manual, Chapter 5). However, the Welcome screen language 
depends on the Tablet Browser’s language setting, and the Login screen is always 
in English.
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5.2.2 Show Own Services

Opens the screen with the list of all services assigned to you.

With this item, you can accept and reject services in the list and mark performed services 
as Done.

Figure 5-16 Tablet Opening Screen - Service Attendant’s Services 

Loc

Displays the location where the service should be performed.

Service

Displays the text of the requested service and the details (if available). 

To see more details, click the service text and the Detailed service view screen 
appears.
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Figure 5-17 Tablet - Detailed Service View

Location

Displays where the service should be performed.

Description

Contains the service text and available details.

Modified at

Displays the date and time of the last modification of the service request.

Guest

Displays the name of the guest for whom the service should be performed.

Status

Contains an icon or icons describing the service status. Use the icons to accept and 
reject services or to mark performed services as Done (see Status icons below.)

Back to service list

Returns to the Show own services screen.
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Status icons

With status icons you can accept and reject services assigned to you, and also mark 
services as Done. Status icons are displayed next to individual services in the opening 
screen and in the Status line of the Detailed service view screen.

Accepts the service. The checkmark turns green, the Front Office staff is informed that 
you have accepted the service and you have to perform it within a defined time. The 
red cross icon disappears.

Rejects the service. The Front Office staff is informed that you have rejected the 
service and the service disappears from the list of your services.

Marks the service as Done. The service disappears from your service list and the Front 
Office staff is informed.

5.2.3 Request New Service

Opens the screen for requesting new services.

7 There is no undo to accepting, rejecting and marking the services as Done!

7
Use this function only to request new services which are not your responsibility 
(e.g. leaking pipes) or which you are not able to perform at the moment (e.g. you 
notice a broken ash-tray that needs replacing or you meet a guest who asks you 
to organize him a bottle of wine).
You must not reject services that have been assigned to you and then make a 
new request using this function!



Service Tracking

 A31003-E1325-U100-4-7619, 09-2008
5-30 HHSC V2.5 Entry, User Guide

        

u-chap5-V26_en.fm

Service Tracking - Tablet Device

Figure 5-18 Tablet - Creating a New Service Request - Step 1

Location

Select the location the service is requested for.

Code, Text

Select the service code or text. The other field will be filled in automatically. However, 
check the entry. The field displays the first item in the list of all possible entries 
connected with the entry in the other field.

Confirms your entries and opens the next step screen.

Returns to the original screen without any changes.

To request a new service, enter the location and the service code or text with the 
respective drop-down list boxes and confirm with Next >. Enter either the code or the text, 
the other information will be filled in automatically.
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Figure 5-19 Tablet - Creating a New Service Request - Step 2

Please enter information for the new service reques t

Enter comments (if necessary).

Confirms the entries and submits the request to Front Office.

Returns to the previous screen.

>
To enter a comment, click inside the comment field. Use the keyboard which 
appears in the lower part of your Tablet to enter a comment. To hide the 
keyboard, click outside the comment field.
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Figure 5-20 Tablet - Creating a New Service Request - Step 3

The new service request has been saved! 

This screen provides you with the summary of the requested service.

Location

Displays the location of the requested service.

Code

Displays the code of the requested service.

Text

Displays the text of the requested service.

Comment

Displays remarks concerning the service (if available).

Back to service list

Returns to your service list.
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5.2.4 Show Other Services

Provides an overview of services assigned to other service attendants or services 
requested for a certain location.

Figure 5-21 Tablet - Displaying Other Services - Step 1

for Service attendant

To view the services of service attendants, select this radio button, select a service 
attendant in the drop-down list and click Display.

for Location

To view the services requested for a location, select this radio button, select a location 
and click Display.

Opens a screen with the services for the selected service attendant (for Service 
attendant option button selected) or for the selected location (for Location option 
button selected).
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Services for a Location

Figure 5-22 Tablet - Displaying Other Services - Step 2

Services for Location

Shows the location number.

Service

Below the heading you can see the description of the service, together with status 
icons describing the service status.

To view more details concerning a service, click the service text and the Detailed 
service view screen opens (see Figure 5-17).
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5.2.5 Break

Sets or cancels your breaks.

Figure 5-23 Tablet - Unsuccessful Attempt to Set a Break (left) and Break (right)

Attempts to set the break again if the break was not set up successfully.

Ends your break.
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5.2.6 Logout

With this icon you log out.

Figure 5-24 Tablet- Logout

Logs you off.

Returns you to the screen with your service list (see Figure 5-16).

5.3 Other Transmission Routes (SMS, Email)

The service attendants in your hotel can use the following devices for Service Tracking:

● Email and

● SMS messages
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> Email and SMS are used only for informing service attendants that new service 
request has been assigned.
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6  Telephone Interfaces

6.1 Setting Wakeup Calls with Voice Prompt

Using the HSC telephone interface the guests of your hotel can set wakeup calls via the room 
telephone and delete them again.
To guide guests by means of voice prompts, the internal Advanced Messaging System has to 
be configured (see Service Manual). Otherwise guests can set or delete wakeup calls only 
without acoustic confirmation (cp. Section 6.2, “Setting Wakeup Calls without Voice Prompt”).

When the guest presses the wakeup call button on the phone,  checks whether a wakeup call 
has already been set. If a wakeup call has already been set, the guest is notified of this fact by 
a voice announcement and the guest can then either delete or change the wakeup call by 
means of the telephone keypad.

Otherwise the guest is offered the option to set a wakeup call by using the telephone keypad.  
The guest has the option to set the wakeup call in such a way that he is awakened every day 
at the same time.

6.2 Setting Wakeup Calls without Voice Prompt

Using the internal Basic Wakeup Call System (HSC telephone interface; see Service Manual), 
the guests of your hotel can set or delete wakeup calls via the room telephone also without 
voice prompt.

The entries via the telephone keypad have to begin with a prefix and end with the asterisk “*” 
or with the pound key “#”.

Please note that different strings of character have to be used, depending on your PBX version 
(available only for HiPath 3000 systems):

● In HiPath 3000 V6 or newer the prefix for the wakeup call is always *4949001. Thereafter 
the guest has to enter the wakeup time, using four digits, as "hhmm" (24-hours 
representation) and terminate entry with an "*".

● In HiPath 3000 V5 the prefix for the wakeup call is always *4211. Thereafter the guest has 
to enter the wakeup time, using four digits, as "hhmm" (24-hours representation) and 
terminate entry with a "#".

Please see the following notes for entry:

● Each correct entry on the telephone has to be completed with "*" (HiPath 3000 V6 or 
newer) or “#” (HiPath 3000 V5).
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● The character string entered is transmitted to the  system without confirmation or error 
message. If the transported data are not plausible, the function will not be executed (no 
warning message!).

● When the wakeup time is entered, it is not possible to enter a date. The wakeup call will 
always be executed at the "next time possible".
Example: The wakeup time "0800" entered at 5:00 am will be executed on the same day 
at 8:00 am. The wakeup time "0800" entered at 2:00 pm will be executed on the next day 
at 8:00 am.

● The setting of a wakeup call within the next 10 minutes is ignored without further warning 
message!

● After entry of a valid (e.g. formally correct) wakeup time, all wakeup times previously 
entered will be deleted. This means that you can only define one wakeup time within the 
next 24 hours!
If an invalid wakeup time is entered, this entry will be ignored and therefore has no impact 
on wakeup times entered earlier.

● You can explicitly cancel all previously entered wakeup times by entering "8888*" (HiPath 
3000 V6 or newer) or “8888#” (HiPath 3000 V5).

● Thereafter you have to replace the telephone receiver or switch off the loudspeaker.

Examples for valid wakeup call entries:

HiPath 3000 V6 or newer:

*49490010030*: 00:30 --> 30 minutes after midnight
*49490011200*: 12:00 --> noon
*49490010756*: 07:00 hrs and 56 minutes

HiPath 3000 V5:

*42110030#: 00:30 --> 30 minutes after midnight
*42111200#: 12:00 --> noon
*42110756#: 07:00 hrs and 56 minutes

6.3 Changing of the Room Status without Voice Prompt

By means of the  telephone interface the hotel staff can set the room status directly in the 
guest's room via the telephone keypad.

The entries via the telephone keypad have to begin with a prefix and end with the asterisk “*” 
or with the pound key “#”.

Please note that different strings of character have to be used, depending on your PBXversion 
(available only for HiPath 3000 systems):
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● In case of HiPath 3000 V6 or newer the prefix for the room status is always *4949002. After 
that the status (0 for cleaned, 1 for uncleaned) has to be entered and entry has to be 
terminated with an "*".

● In case of HiPath 3000 V5 the prefix for the room status is always *4212. After that the 
status (0 for cleaned, 1 for uncleaned) has to be entered and the entry has to be terminated 
with a "#".

Please see the following notes for entry:

● Each correct entry on the telephone has to be completed with "*" (HiPath 3000 V6 or 
newer) or “#” (HiPath 3000 V5).

● The character string entered is transmitted to the  system without confirmation or error 
message. If the transported data are not plausible, the function will not be executed (no 
warning message!).

● Thereafter you have to replace the telephone receiver or switch off the loudspeaker.

Possible room status entries:

HiPath 3000 V6 or newer:

*49490020*: Set room to cleaned
*49490021*: Set room to uncleaned

HiPath 3000 V5:

*42120#: Set room to cleaned
*42121#: Set room to uncleaned

6.3.1 Service Functions of the Telephone Interface

The telephone dialog for service functions for service attendants can be accessed by default 
via the wakeup call button.

Below flowcharts show how service attendants can use the following HSC-specific service 
functions after entering the respective "menu numbers" via the telephone. 

"1": Change of room status

"2": Entering of minibar consumption

>
Only those members of the hotel staff are authorized to execute service functions by 
means of the telephone dialog who in the HSC administration have been defined as 
service attendants and to whom also a identification code has been assigned (see 
Administration Manual).
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Figure 6-1 Service Access of the Telephone Interface, Flowchart

Please note:

● At the beginning of each telephone dialog the identification code has to be entered. If three 
wrong entries are made, HSC Connect will cancel the dialog.

● At the end of the telephone dialog the executed activity is confirmed by the respective 
announcement or an error note is announced.

6.3.1.1 Changing of the Room Status

The room whose status is to be changed is identified automatically during the telephone dialog 
from the assignment extension of the telephone dialog < --- > room number. 

As a new room status one of the digits "0" or "1" can be entered.
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Figure 6-2 Change of Room Status, Flowchart

6.3.1.2 Entering of Minibar Consumption

The room whose minibar consumption is to be entered via the phone is identified automatically 
during the telephone dialog from the assignment extension of the telephone dialog < --- > room 
number. 

After identification of the room, HSC Connect expects the input of a product number, followed 
by the amount of the items consumed. After entry of product number and amount of items 
consumed, the system repeats your entries and requests a confirmation with "1" for 
continuation of processing or "#" for termination of processing.

> HSC Connect does not check the product numbers entered for plausibility but 
forwards them directly to the connected Cloud PMS.
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Entering of Minibar Consumption, Flowchart
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A Appendix A - Adaptation of Reports

HSC Entry already comes with Microsoft Word templates, which you can adjust according to 
your needs. What is important, however, is that you use the variables provided in the template. 
If you want HSC Entry to print out a reservation confirmation or a charge list, HSC Entry will 
start Microsoft Word with the required template and replace existing variables with the 
respective values.

Please see C:\PSE\HSC\Tomcat\modules\HSC_reporting\reports\wordTemplates for the 
supplied default templates with the following names:

> ChargeList_DE.dot

> ChargeList_EN.dot

> ChargeListShort_DE.dot

> ChargeListShort_EN.dot

> GroupReservationConfirmation_DE.dot

> GroupReservationConfirmation_EN.dot

> ReservationConfirmation_DE.dot

> ReservationConfirmation_EN.dot

>
To be able to use the modified templates, you will have to specify in the HSC Entry 
administration GUI (see Service Manual) that Microsoft Word can be used as editor 
for reservation confirmations and the charge list (i.e. activate the Using MS Word 
checkbox in Administration > System Settings... > Reporting). In addition, please 
enter the names of the templates.

7
Please note that, by purchasing HSC Entry, you have not purchased the license for 
Microsoft Word!
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A.1 Charge List

HSC Entry supplies the Microsoft Word template presented in Figure A-1, which you can fit to 
your requirements. Of course you can also define a new template. Please make sure to make 
the required settings in the administration settings (see Service Manual).

Include adjustments you want to make in all charge lists in the template. However, changes 
that apply only in some cases should be included after opening the preview of the currently 
created charge list directly in Microsoft Word. To make sure that such a changeable preview 
really is displayed on the screen, the checkbox Using MS Word has to be activated in the 
administration settings (see Service Manual) and the checkboxes Print report immediately 
upon reservation/check-out and Print charge list immediately must not be activated.

If you never have to make changes to the contents of a charge list, we recommend activating 
the checkboxes Print report immediately upon reservation/check-out and Print charge list 
immediately in the administration settings (see Service Manual).

Figure A-1 Default Template for Charge Lists
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Reservation Confirmation

HSC Entry fills the following variables with the current data: 

– Name of the guest

– Room number

– Arrival date

– Departure date

– Generation date of the charge list

– Net price, gross price, total price of the services

– Other call charge information (called number, time of the phone call, duration of the 
phone call).

A.2 Reservation Confirmation

HSC Entry supplies the Microsoft Word template presented in Figure A-2, which you can fit to 
your requirements. Of course you can also define a new template. Please make sure to make 
the required settings in the administration settings (see Service Manual).

Include adjustments you want to make in all reservation confirmations (e.g. name and address 
of the hotel) in the template. However, changes that apply only in some cases (e.g. price) 
should be included after opening the preview of the currently created reservation confirmation 
directly in Microsoft Word. To make sure that such a changeable preview really is displayed on 
the screen, the checkbox Using MS Word has to be activated in the administration settings (see 
Service Manual) and the checkbox Print report immediately upon reservation/check-out must 
not be activated.

If you never have to make changes to the contents of a reservation confirmation, we 
recommend activating the checkbox Print report immediately upon reservation/check-out in the 
administration settings (see Service Manual).
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Reservation Confirmation

Figure A-2 Default Template for Single Reservation Confirmations

HSC Entry fills the following variables with the current data: 

– Name of the guest

– Room number

– Arrival date

– Departure date

– Remark on the reservation
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Nur für den internen Gebrauch List of Abbreviations

List of Abbreviations Y

This table shows some important abbreviations.

Abbreviation Definition

CAPI Common ISDN Application Programming Interface

DND Do Not Disturb

HSC Hospitality Service Center

HTML Hypertext Markup Language

PDF Portable Document Format

VoIP Voice over Internet Protocol

XML EXtensible Markup Language
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Nur für den internen Gebrauch Index

Index Z

A
About information  4-5
Adaptation

charge list  A-2
reports  A-1
reservation confirmation  A-3

Advanced search, service request  5-5
Arrival list  2-20
Arrival report  3-7

B
Basic functions of HSC Front Office  4-1
Break, Tablet  5-35
Button bar

for Service Control  5-21
for service request  5-13

Buttons
copy service request  5-22
edit service request  5-21
print service request  5-13, 5-22
remind service request  5-13
save and submit service request  5-13
save service request  5-13

C
Call authorization

lock  2-18
Call Control

list of call-relevant service requests  5-17
Cashier  2-10
Category

service request  5-8
Charge list  2-9, 3-8
Check-in  2-6

after reservation  2-7
group  2-7
quick check-in  2-7
without reservation  2-7

Check-out  2-8
Code

service request  5-7
Colors

for Service Control  5-21
Comment for service request  5-7
Complaint

service request  5-7
Confirmation

reservation  2-6
Copy

service request  5-22
Counter

service control  5-21

D
Department

service request  5-8
Departure list  2-22
Departure report  3-7
Details, service request  5-7

Tablet  5-27
Display

events  4-4
room availability  4-4
timeline scrollbar  4-4

DND  2-17
Do not disturb  2-17

E
Edit

service request  5-21
Event calendar  2-15
Events  4-4
Exit  4-3

F
Feedback

service request  5-10
Filter

Service Control  5-15
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G
General account  2-14
Group reservation  2-5
Guest cashier  2-10

H
Help  4-5, 4-6
HSC Entry main desktop  4-1

I
In-house report  3-7
Initiator

service request  5-4, 5-20
Internet access

lock  2-18
Invoice  2-13
Invoicing  2-13

L
List of call-relevant service requests  5-17
Location

service request  5-7
Lock

call authorization, Internet access  2-18
Login

Front Office  1-3
Tablet  5-23

Logout
Front Office  4-3
Tablet  5-36

M
Main desktop areas

navigation area  4-1
working area  4-3

Menus
General  4-3
Help  4-4
view  4-4
Window  4-4

Message window  4-6
Messages  2-18
Minibar consumption

telephone dialog  6-5

N
Navigation area  4-1
New folio  2-12
New service request  5-2

time to send  5-10
Notification with ringing

service request  5-12

O
Occupation  2-8
Online help  4-5, 4-6

P
Password  1-3
Payment  2-13
Print

service request  5-13, 5-22
work list  3-5

Q
Quick check-in  2-7
Quick overview on HSC Entry  1-4

R
Remind

service request  5-13
Repeat

service request  5-11
Report  3-1

arrival report  3-7
charge list  3-8
control area  3-6
departure report  3-7
in-house report  3-7
navigation bar  3-5
output area  3-4
parameter entry area  3-3
print  3-5
room status list  3-7
selection area  3-3
structure  3-2, 3-4
wakeup call list  3-9

Request a new service
Tablet  5-29

Reservation
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for groups  2-5
for individuals  2-3

Reservation confirmation  2-6
Room availability  2-15, 4-4
Room grid  2-1

event calendar  2-15
room availability  2-15
time navigation  2-3

Room status  2-19
changing by telephone dialog  6-2

Room status list  3-7

S
Satisfaction level

service request  5-10
Save

service request  5-13
Save & submit

service request  5-13
Search

Service Control  5-16
service request  5-5

Search result list  5-16
Separated invoices  2-12
Service

advanced information  5-9
category  5-8
code  5-7
comment  5-7
complaint  5-7
create a new request  5-2
define time to send  5-10
department  5-8
details  5-7
details (Tablet)  5-27
feedback  5-10
initiator  5-4, 5-20
location  5-7
request

number  5-12
repeat  5-11
status  5-12, 5-19

satisfaction level  5-10
search  5-5

solution  5-10
text  5-7
transmission route  5-9
type  5-7

Service attendant  5-8, 5-20
Service Control  5-15

colors  5-21
filter  5-15
search  5-16
search result list  5-16
service request filtering list  5-15

Service control
counter  5-21

Service functions
telephone dialog  6-3

Service request
basic information  5-6
copy  5-22
edit  5-21
notification with ringing  5-12
print  5-13, 5-22
remind  5-13
save and submit  5-13
save only  5-13

Service request filtering list  5-15
Service Tracking  5-1

new service request  5-2
Service Control  5-15
Tablet  5-23

Show other services (Tablet)  5-33
Show own services (Tablet)  5-27
Solution

service request  5-10
Status

service request  5-12, 5-19
System messages  4-3

T
Tablet

break  5-35
login  5-23
logout  5-36
request a new service  5-29
show other services  5-33
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show own services  5-27
status icons  5-29

Target group
for User Guide  1-1

Telephone dialog
changing of room status  6-2
wakeup calls with voice prompt  6-1
wakeup calls without voice prompt  6-1

Telephone interface
minibar consumption  6-5
service functions  6-3

Template  A-1
default  A-1, A-2, A-4
for charge list  A-2
for reservation confirmation  A-3

Text
service request  5-7

Time navigation in room grid  2-3
Time to send

new service request  5-10
Timeline scrollbar  4-4
Transmission route

Kirk  5-36
service request  5-9
Tablet  5-23

U
User account  1-3
User Guide

notational conventions  1-2
quick overview on HSC Entry  1-4
structure  1-2
target group  1-1

W
Wakeup call  2-16

setting by telephone dialog  6-1
Wakeup call list  3-9
Wakeup calls with voice prompt  6-1
Wakeup calls without voice prompt  6-1
Work lists  3-1

arrival report  3-7
charge list  3-8
control area  3-6
departure report  3-7

in-house report  3-7
navigation bar  3-5
output area  3-4
parameter entry area  3-3
print  3-5
room status list  3-7
selection area  3-3
structure  3-2, 3-4
wakeup call list  3-9

Working area  4-3
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